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Editing records

Press ENTER or any letter/digit to edit the contents of the current field. To accept new data press ENTER once again or use one of 

the following cursor keys: Left, Right, Up, Dn, PgUp, PgDn. Pressing ESC will return the original value. GS-Base performs text 

length validation as text fields are modified. When editing you may press SHIFT and click another field to copy its contents to the 

currently edited field.

If you press ENTER to edit an empty cell, the program automatically inserts the default value (number, text or formula) defined in the 

Field Properties dialog box. To insert the default value for all record at once, use the Convert command from the Edit menu.

The changes are saved automatically when you scroll the current row.

You may split the active document window into two panes to retrieve records in a table and in a single-record form. To change the 

active pane click it or press F6 (+SHIFT).

When retrieving the database you may use the standard cursor keys: Left (+Ctrl), Right (+Ctrl), Up, Dn, PgUp (+Ctrl), PgDn (+Ctrl), 

Home, End.

See: Entering numbers, formulas, text, date and time, Searching for records



Entering numbers, formulas, text, date and time

GS-Base automatically recognizes the type of the entered data. Numbers having more than 15 digits are displayed in an exponential 

format. If a number length exceeds a column width, the program displays a string of "#" characters.

When editing a number field, you may enter any expression including numbers and formulas. The expressions may contain the field 

names. GS-Base evaluates such an expression and saves the computed value. To browse all available formulas use the Paste 

Formula command from the Edit menu.

When editing a date/time field GS-Base uses the current Windows settings (short date and time format) to validate the entered text. 

For example, if you define the current date and time as "M/d/rr" and "h:mm:ss tt", the following expressions will be valid: "1/01/97", 

"1/01/1997", "11:00 AM 1/01/97", "1/01/97 11:00 AM", "11:00 PM".

Examples:

(numbers)

5

5,56

12,45e+12

-1995

23%

(formulas and references- Product price, Discount, 

Argument, Precision and Months are the sample field 

names)

Product price - Discount

Total/12 +FACT(Argument)

ROUNDX(999,99; Precision) + 10

FVAL(1000; 1%; Months)

FVAL(1000; 0,01; Months)

Using linked documents

GS-Base enables you to open or print documents whose names (paths) are placed in the database fields. The field contents may 

contain a file name, folder name, Internet site name or Internet URL. In general, you may use a name representing any document as 

long as you have a respective program which can open or/and print such a document.

The Open Document and Print Document commands are attached to the Edit menu and the context menu.



Searching for records

Press CTRL+ENTER, use the Edit command from the Edit/Search Key menu or double-click the column heading to change the 

search expression for the current field. To accept new data press ENTER. Pressing ESC will return the original value.

After accepting a new search expression, GS-Base will update the displayed record set (unless you turned off the "auto search" 

mode in the Options dialog box). When closing the database, GS-Base saves the current search keys.

The "AUTO" text string displayed on the status line indicates that the table will be refreshed after each change of any search 

expression.

Note: If you would like to add more than one expression before searching is performed, press TAB (+SHIFT) or use the Left/Right 

keys to switch among the edited cells.

The "FILTER" text string displayed on the status line indicates that a search expression has been entered for at least one field.

The search expressions may have the following syntax (please note that - except the second method - the "text" expression can 

refer to a text string, a number or a date/time value):

Syntax Searching for records which meet the following 

conditions:

text Field contents = text (text may be a prefix)

*text Field contents must ends with text

{text1;text2;...;textN} Field contents = text1 OR Field contents = text2 OR ... 

OR Field contents = textN

<text1;text2> Field contents >= text1 AND Field contents <= text2

(text1;text2) Field contents > text1 AND Field contents < text2

You may combine the described search expressions. For example, the following expressions are valid: {*text1;*text2;...;textN},    

<text1;text2),    (text1;text2>,    (text1;),    <text1;>,    (;text2),    <;text1).

Note:

1. Do not insert spaces between arguments of the search expressions if it should refer to a text field.

2. By default search is case sensitive. To change that use the Options command.

In the following example GS-Base will search for persons

- whose numbers are greater than 10 and smaller or equal to 100 and

- whose first names start with A, B or C and

- whose last names end with "son" and

- who work in New York in companies which names begin with M.



Using predefined search keys

GS-Base enables you to use some predefined search keys. These "special" keys can't be expressed as a list of simple search 

conditions. Using them you may search for duplicate or selected records, duplicate field values or for records which constitute the 

complement of the current record set. You may choose the predefined keys from the Search Toolbar.



Sending bulk e-mail messages

GS-Base enables you to send bulk e-mail messages with customized forms and file attachments. It supports MIME encoding 

(base64, quoted-printable) and text/html message forms. After choosing the Send E-mail Messages command from the Table 

menu the program displays easy to navigate wizard-style dialog boxes. They help you to specify all necessary data before and even 

after the sending process is started. The procedure is performed as a separate program thread and can be run independently for 

each open document.

Step 1.

Select the database field that contains the recipients' e-mail addresses. Enter your e-mail address, server name and server channel. 

By default the "From" and "Reply-To" fields in the message header contain the same e-mail address. If you want to use a different 

one for the "Reply-To" field, add it to the Email Address edit field, separating the two addresses with a semicolon (;). Once you 

enter the data, you may click the Save As Default button to save it.

Step 2.

Select the message form. This can be any text or HTML document. The message form may contain references to the database 

fields. The embedded fields are represented by their names enclosed in double curly braces {{,}}. For example, if there are two 

fields: Customer and Number, the form may look like this:

Dear {{Customer}},

Here is your registration number: {{Number}}.

You may specify the character set and the text encoding for your messages. In general, you should use the "quoted-printable" 

encoding for the html forms. The file attachments can be specified as files or database fields containing file paths. The second 

method enables you to customize the attachments list for each message. Optionally you can change the file attachment description 

which will appear in the message headers.

There are no limits for the form size, the number of references in the single message or for the number of attachments.

Step 3.

Click the Send button to start sending messages. You may also earlier click the Save As File button to save all or part of them to a 

text file. As soon as you start e-mailing, all e-mail addresses and values of the embedded fields are cached, so you may continue 

editing the current database. However, if you modify the current record set, suspend and then resume the process (pressing the 

Pause button and then again the Send button) it will use the updated data. Similarly, you may always change the message form, file 

attachments and other settings after pressing the Pause button.

The sending order corresponds to the records order.



Printing tables, forms and labels

GS-Base supports three methods of printing:

(1) printing records in tables,

(2) printing records in single-record forms,

(3) printing forms created with GS-Calc.

Note: The printing procedures always refer to the currently found records.

By default GS-Base prints records in tables. If you want to print records using the predefined single-record form, split the main 

document window into two panes and select (with a mouse click or pressing the F6 key) that one which displays a single record. At 

this point the print mode is changed. To restore printing tables select the previous pane.

GS-Base enables you to print any forms, labels or reports created with GS-Calc. In order to use the GS-Calc documents for printing, 

choose the first print mode and specify the form names in the Properties/Forms dialog box.

Forms created with GS-Calc may have any size and may contain any data, including formats, formulas, charts and OLE objects. 

The document cells which contain the database field names are treated as references to these fields. Please note that each field 

name must be placed in a separate spreadsheet cell. Before printing each page GS-Base substitutes the corresponding field values 

for all references and updates all formulas and charts. The program automatically recognizes and groups references to the fields of 

the same record. Each occurrence of the same field is assumed to be a reference to the next record.

The following examples show how the various forms may look when edited in GS-Calc. The "Company", "Street", "City", "Zip code", 

"Sales in January", "Sales in February", "Sales in March" names are sample field names.

Note: When printing forms GS-Base uses the GS-Calc document's page settings (including margins and grid lines) rather than the 

default database page settings.

1.

2.

3.

4.





Changing the database definition

Use the Properties command from the File menu to change the current database definition. You may add or delete fields, change 

their names, types and lengths. As long as you don't delete a given field, the modified database will contain the contents of that field. 

If you change the field type or length, GS-Base performs all necessary conversions.



Changing the fields order

Use one of the following methods to change the default field order:

(1) Drag the header of the chosen field to the desirable position.

or

(2) Use the Field Properties command from the Table menu. Then choose the General page and select the desirable field name 

from the field list. After changing the list selection GS-Base switches the positions of the current and selected field.



Using Drag-Drop functions

Use the Drag-Drop functions to copy field contents or to open an existing GS-Base database. To open an existing database drag its 

name from within Explorer window to the GS-Base window.

To copy the field contents press and hold down the CTRL key and drag the mouse pointer to the new position. You may copy the 

field contents within the same table, between different tables or between different programs (as long as they use this functions).



Importing and exporting databases

When importing and exporting databases to the various formats GS-Base uses the following field types:

Type Length in 

bytes

Description

Text 0-255 Text and numbers.

Memo * Lengthy text, such as comments or explanations. A Memo field's 

size is limited by the maximum size of the database.

Long 4 Integer values from 2,147,483,648 to 2,147,483,647.

Boolean 1 Yes/No, True/False, 1/0. A field that contains only one of two 

values.

Byte 1 Positive values from 0 to 255. 

Integer 2 Integer values from –32,768 to +32,767.

Single 4 3.402823E38 to 1.401298E–45 for negative numbers and 

1.401298E–45 to 3.402823E38 for positive numbers.

Double 8 Values from 1.79769313486232E308 to 4.94065645841247E–324 

for negative values and 4.94065645841247E–324 to 

1.79769313486232E308 for positive values.

Date 8 Dates and times (stored together). These values are stored in a 8-

byte field and may be treated as a 8-byte floating point number. The 

(positive or negative) integer portion represents the number of days 

from 30 December 1899, midnight and the fractional portion 

represents hours.

Long binary * Any value that can be represented in binary (like pictures or OLE 

objects created in other programs) up to 1.2 gigabytes in size.

Currency 8 Used for monetary values. This data type maintains a fixed number 

of digits to the right of the decimal point, which helps in avoiding 

improper rounding during calculation.

If you choose a field type that doesn't apply to the given format, the type that matches it as close as possible will be used.

The GS-Base native format supports Text, Double and Date fields. If the destiny/source database uses the remaining field types, the 

program takes care of the proper conversion. For example, the following rules may be applied: number to date, number to text, date 

to number, date to text, text to date, text to number etc.

Please note that GS-Base doesn't import binary fields and doesn't export binary and memo fields.



Changing the number format

GS-Base uses the format defined in Windows as a part of the current international settings. You may change it using Control Panel.



Changing the currency, date and time format

GS-Base uses the format defined in Windows as a part of the current international settings. You may change it using Control Panel.



Changing the default font

GS-Base saves some its parameters in the registry database. It uses the following key name:

HKEY_CURRENT_USER\Software\JPS Development\GS-Base

Change value of the MainFont entry in this key to change the global font used by GS-Base. The default name is "Arial".



Commands

File

Edit

View

Table

Window

Help



File menu

New

Open...

Save

Save Copy As

Print

Print Preview

Print Setup

Page Setup

Password

Properties

Send

Exit



Edit menu

Undo

Redo

Repeat

Cut

Copy

Copy E-mail Addresses

Paste

Paste Formula

Delete

Search Key

Insert File Name

Open Document

Print Document

Find

Replace

Convert



Search Key menu

Change

Remove



View menu

Status Bar

Standard Toolbar

Search Toolbar

Zoom

Grid



Table menu

Sort

Field Properties

Send E-mail Messages

Go To

Select Record

Select Group

Remove Records

Options



Sort menu

Ascending

Descending



Window menu

Split

Cascade

Tile Horizontally

Tile Vertically

Arrange Icons



Help menu

Help Topics

About GS-Base



New command (File menu)

Use this command to create a new database.



Open command (File menu)

Use this command to open an existing database. You can open multiple databases at once. Use the Window menu to switch among 

the multiple open windows.

Note: It is important to select a proper file type from the File Types list in the Open dialog box.



Close command (File menu)

Use this command to close the active document window.



Save command (File menu)

Use this command to save the active database to its current name and directory.



Save Copy As command (File command)

Use this command to create a copy of the current database.

Note: Only the currently found records are copied to the new database.



Page Setup command (File menu)

Use this command to change page layout.



Password command (File menu)

Use this command to change the current password.



Properties command (File menu)

Use this command to display and change the database properties.

Note: You may add or delete fields, change their names, types and lengths. As long as you don't delete a given field, the modified 

database will contain the contents of that field. If you change the field type or length, GS-Base performs all necessary conversions.



See: Changing the database definition



See: Changing the database definition



See: Changing the database definition



See: Changing the database definition



Link command (File menu)

Use this command to import records from an existing GS-Base database. Both databases must have the same definition.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you closed. Choose the 

number that corresponds with the document you want to open.



Send command (File menu)

Use this command to send the active document through electronic mail (or fax). This command presents a mail window with the 

active document attached to it. You may then fill out the To: field, Subject: field, etc., and add text to the body of the message if you 

wish. When you are finished you may click the "Send" button to send the message.



Exit command (File menu)

Use this command to end your GS-Base session.



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible. The name of the command changes, depending on what the last 

action was.



Redo command (Edit menu)

Use this command to redo the last reversed editing action, if possible. The name of the command changes, depending on what the 

last action was.



Repeat command (Edit menu)

Use this command to repeat the last editing action, if possible. The name of the command changes, depending on what the last 

action was.



Cut command (Edit menu)

Use this command to remove the currently selected field and put it on the clipboard.

Cutting data to the clipboard replaces the contents previously stored there.



Copy command (Edit menu)

Use this command to copy the currently selected field or column onto the clipboard.

Copying data to the clipboard replaces the contents previously stored there.



Copy E-mail Addresses command (Edit menu)

Use this command to save the values from the current column and copy them to the clipboard. The copied text strings are assumed 

to be e-mail addresses. They are stored in the format required by mailing programs. For example, if the column contains the 

"name1@company1.com", "name2@company2.com", ....,"name100@company100.com" text strings, the clipboard contents will be: 

"name1@company1.com; name2@company2.com; ...;name100@company.com". Then, the data can be easily inserted into the 

"To:" field of your mailing program.



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents to the currently selected field. This command is unavailable if the 

clipboard is empty or doesn't contain text data.



Delete command (Edit menu)

Use this command to remove the currently selected field.



Change command (Edit/Search Key menu)

Use this command to edit the search expression for the currently selected field.

See: Searching for records



Remove command (Edit/Search Key menu)

Use this command to remove all search expressions for all fields. Using this command will result in displaying all records.



Paste Formula command (Edit menu)

Use this command to paste a formula into the current cell. After choosing this command GS-Base displays the Paste Formula 

dialog box which enables you to retrieve all available formulas.



Insert File Name command (Edit menu)

Use this command to insert a file name into the current field. The presented Insert File dialog box enables you to browse existing 

files and folders.



Open document command (Edit menu)

Use this command to open a document whose paths (or name) is placed in the current field. This can be a file name, folder name, 

Internet site name or Internet URL. In general, you may use any document as long as you have a respective app which can manage 

such documents.



Print Document command (Edit menu)

Use this command to print a document whose paths (or name) is placed in the current field. This can be a file name, folder name, 

Internet site name or Internet URL. In general, you may use any document as long as you have a respective app which can manage 

such documents.



Find command (Edit menu)

Use this command to search the active database for text. While comparing text GS-Base uses unformatted cells contents.

If you select any column before using this command, the search will be limited to this column.



Replace command (Edit menu)

Use this command to find and replace text in the active database. While comparing text GS-Base uses unformatted cells contents.

If you select any column before using this command, the search will be limited to this column.



Convert command (Edit menu)

Use this command to convert the current field in all records.



Replace dialog box

See: Replace command



Find dialog box

See: Find command



Standard Toolbar command (View menu)

Use this command to display and hide the Standard Toolbar, which includes buttons for some of the most common commands in 

GS-Base, such as File Open. A check mark appears next to the menu item when the Toolbar is displayed.



Standard Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick mouse access to 

many tools used in GS-Base.

To hide or display the Toolbar, choose the Standard Toolbar command from the View menu



Search Toolbar command (View menu)

Use this command to display and hide the Search Toolbar, which includes the list of the predefined search keys.



Search Toolbar

The Search Toolbar is displayed across the top of the application window, below the menu bar. The Search Toolbar provides quick 

mouse access to all predefined search key that may be used by GS-Base. These are search keys that can't be expressed as a list 

of search conditions.

To hide or display the Search ToolBar, choose the Search Toolbar command from the View menu



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected menu item or 

depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item when the Status Bar is displayed.



Status Bar

The status bar is displayed at the bottom of the GS-Base window. To display or hide the status bar, use the Status Bar command in 

the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. This area 

similarly shows messages that describe the actions of toolbar buttons as you depress them, before releasing them. If after viewing 

the description of the toolbar button command you wish not to execute the command, then release the mouse button while the 

pointer is off the toolbar button.

The right areas of the status bar contain five indicators:

Indicator Description

Records number The number of found records.

FILTER You entered some search expressions.

AUTO Automatic search mode is on - every change of the search expression will result in new search

CAP Caps Lock is on.

NUM Num Lock is on.



Zoom command (View menu)

Use this command to change the current displaying scale.



Grid command (View menu)

Use this command to show or hide the table grid.



Sort Ascending command (Table/Sort menu)

Use this command to sort the current record set in ascending order. The sorting function treats hyphens and apostrophes in a 

special way in order to ensure that words such as "coop" and "co-op" stay together within a sorted record set. The comparison is 

case sensitive and is determined by the language selected by the user at setup time or via the control panel.



Sort Descending command (Table/Sort menu)

Use this command to sort the current record set in descending order. The sorting function treats hyphens and apostrophes in a 

special way in order to ensure that words such as "coop" and "co-op" stay together within a sorted record set. The comparison is 

case sensitive and is determined by the language selected by the user at setup time or via the control panel.



Field Properties command (Table menu)

Use this command to change the properties of the current field. This command presents the Field Properties dialog box which 

enables you to change the field position, displayed name (which may differ from the field name), the default value and the field 

format.



Send E-mail Messages command (Table menu)

Use this command to send (bulk) e-mail messages. This command displays the "Send E-mail Messages" dialog box for the current 

database. You may open one such a dialog box for each open document.

See: Sending bulk e-mail messages



Go To command (Table menu)

Use this command to scroll the current row to a given record.



Select Record command (Table menu)

Use this command to set or remove selection for the current record.



Select Group command (Table menu)

Use this command to set or remove selection for a group of records. 



Remove Records command (Table menu)

Use this command to remove records from the current database.

Note: This action can't be undone.



Options command (Table/Format menu)

Use this command to display the Options dialog box which enables you to change the program's settings.



Split command (Window menu)

Use this command to split the active document window into two panes which present records in a table and in a singe-record form.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an open document 

window at the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this 

document window.



1, 2, ... 

GS-Base displays a list of currently open document windows at the bottom of the Window menu. A check mark appears in front of 

the document name of the active window. Choose a document from this list to make its window active.



Help Topics command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step instructions for 

using GS-Base and various types of reference information.



About GS-Base command (Help menu)

Use this command to display the copyright notice and version number of your copy of GS-Base.



Context Help command

Use the Context Help command to obtain help on some portion of GS-Base. When you choose the Toolbar's Context Help button, 

the mouse pointer will change to an arrow and question mark. Then click somewhere in the GS-Base window, such as another 

Toolbar button. The Help topic will be shown for the item you clicked.



Titlebar

The title bar is located along the top of a window. It contains the name of the application and document. To move the window, drag 

the title bar.

Note: You can also move dialog boxes by dragging their title bars.



Scroll Bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars indicate your vertical and 

horizontal location in the document. You can use the mouse to scroll to other parts of the document.



Editing records
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Editing records



Installing GS-Base

System requirements:

- PC with Windows 95/NT

- 4.5 MB free disk space (1.5 MB without database drivers).

To install GS-Base run SETUP.EXE program. After successful installation GS-Base displays message: "Installation complete.".

If the DAO database drivers have not been installed in your system, the following files will be copied to the Windows\system 

directory.

DAO3032.DLL (to the \Program Files\Common Files\Microsoft Shared\Dao directory)

MSJT3032.DLL

MSJTER32.DLL

MSJINT32.DLL

VBAJET32.DLL

VBAR2232.DLL

VEN2232.OLB

MSVCRT20.DLL

MSRD2X32.DLL

MSXB3032.DLL

MSPX3032.DLL

MSXL3032.DLL

Note: GS-Base uses these DLLs exclusively for importing and exporting data to the various formats.



Customer support

If have any problems with this product or if you have any suggestion, please contact:

E-mail: support@jps-development.com

Web: http://www.jps-development.com

JPS Development

ul. Chopina 13

58-100 Swidnica, Poland

tel.:    0048-74-537581

fax:    0048-74-537581



No help available

No help is available for this area of the window.



No help available

No help is available for this message box.



Specifies the color used to display the selected records. Click this button to change the current color.



Specifies the name of the table and its fields you want to read. A check mark which appears in front of the field name indicates that 

the field will be included. If you are opening a database which contains more than one table in a file, the name of the table may differ 

from the file name.



Specifies fields you want to read from the selected table.



Specifies the expression to be used as a filter for records you want to read. This may be a string conforming to the SQL WHERE 

clause syntax. You may leave this field blank.

Examples:

(1) City>="Ne" AND Number=12

(2) City<= "W" OR Number>10

(3) (April_Sales+May_Sales+June_Sales)/3>50000

(4) Title+Name="Mr.Smith" OR Title+Name="Mr.Jones"

(5) Name LIKE "*son"

Note: You must use square brackets if the field name contains spaces or some special characters (e.g. "[Product number]").



Specifies whether you want to sort records.



Specifies the field that will be used as a sort key. By default GS-Base performs ascending sorting. If you want to perform descending 

sorting, add the DESC keyword to the selected field name (e.g. "Name DESC" instead of "Name").

Note: You must use square brackets if the field name contains spaces or some special characters (e.g. "[Product number]").



Specifies the field name in the new database.



Specifies the field type in the new database. You have to choose one of the several predefined types. After retrieving the database 

fields GS-Base initially selects one of them for each field.

Type Length in 

bytes

Description

Text 0-255 Text and numbers.

Memo * Lengthy text, such as comments or explanations. A Memo field's 

size is limited by the maximum size of the database.

Long 4 Integer values from 2,147,483,648 to 2,147,483,647.

Boolean 1 Yes/No, True/False, 1/0. A field that contains only one of two 

values.

Byte 1 Positive values from 0 to 255. 

Integer 2 Integer values from –32,768 to +32,767.

Single 4 3.402823E38 to 1.401298E–45 for negative numbers and 

1.401298E–45 to 3.402823E38 for positive numbers.

Double 8 Values from 1.79769313486232E308 to 4.94065645841247E–324 

for negative values and 4.94065645841247E–324 to 

1.79769313486232E308 for positive values.

Date 8 Dates and times (stored together). These values are stored in a 8-

byte field and may be treated as a 8-byte floating point number. The 

(positive or negative) integer portion represents the number of days 

from 30 December 1899, midnight and the fractional portion 

represents hours.

Long binary * Any value that can be represented in binary (like pictures or OLE 

objects created in other programs) up to 1.2 gigabytes in size.

Currency 8 Used for monetary values. This data type maintains a fixed number 

of digits to the right of the decimal point, which helps in avoiding 

improper rounding during calculation.

Specifies the length of a given field in the new database. Only the text field length can be changed.



Specifies the list of the currently defined fields. To change name, length or type of a given field select it and edit its description.



Specifies how numbers should be displayed and printed.



Specifies the alignment for the table view.



Specifies whether numbers should contain separators.



Specifies the number of decimal places you want to use when displaying numbers.



Specifies whether the text fields should be displayed in multiline cells in the table view.



Specifies whether to hide the contents of the current field.



Specifies the font for the current field. Press the Font button to change it.



Specifies the group of formulas.



Displays all formulas from the selected group. To paste one of them into the active document double-click it.



Displays descriptions of formulas.



Specifies the current password. The password can consist of 15 characters.



Specifies the current password. The password can consist of 15 characters.



Specifies whether you want the password to be checked only when saving database. Otherwise it will be checked each time you try 

to open the document.



Specifies the current password.



Specifies the text printed at the top (header) and at the bottom (footer) of each printed page. It may contain up to 80 characters. You 

may place the following special characters within this text:

&f Filename

&s File date

&z File time

&d Current system date

&e Current system date - long format

&t Current system time

&p Page number

&l Left aligned (starting from the next character and up to the end 

or to &r/&c characters)

&r Right aligned (starting from the next character and up to the end 

or to &l/&c characters)

&c Centered (starting from the next character and up to the end or 

to &l/&r characters)

Specifies the position of headers and footers.



Specifies whether you want to start the page numbering and the printing headers or footers from the first page.



Specifies whether to print row and column headers.



Specifies whether you want to shrink the printed document so that it can be printed on a single page.



Specifies the print scaling.



Specifies the width of each margin on printed page.



Specifies whether you want to center printed cells horizontally (Horizontal Adjustment) or vertically (Vertical Adjustment).



Specifies the author name.



Specifies the notes which will be stored with the active document file.



Displays the title of the active document.



Specifies the subject of the active document.



Displays the document size.



Displays the date of last saving.



Specifies the displaying scale.



Specifies the character set you want to use when opening or saving the text file. If you choose the OEM character set, GS-Base will 

perform conversion from the OEM to the Windows set.



Select the type of the field separator you want to use when opening or saving the text file.



Specifies whether the first line of the text file should contain the fields names.



Specifies the record number.



Specifies the currently selected field. If you change the selection, the respective column positions will be switched.



Specifies the name to be displayed in the table and in the record view. By default this name and the original field name are the 

same.



Specifies the default value for the current field. This may be any expression containing numbers, formulas or text. If you press 

ENTER to edit an empty cell, the program will automatically insert this value. You may also use the Convert command from the Edit 

menu to insert the default values into the fields of all records at once.



Click this button to browse the list of all available formulas which can be used as the default value.



Displays all available methods of the field conversion. If you click the OK button, the program will change the contents of the current 

field according to the chosen description. This action will be performed for the current record set only.

Note: Some of the conversion types (like converting to uppercase) applies only to text fields.



Specifies how the program should scroll the current selection after accepting a new field contents with ENTER. By default the 

current position is not changed.



Specifies whether the program should perform a new search after each change of the search expressions.



Specifies whether you want to make use only of True-Type fonts. If you don't choose this option, you will be able to select any 

currently installed Windows font when formatting the field contents.



Specifies the undo level. You may enter values from 0 to 16347.



Specifies the color to be used to display the selected records. Click this button to change the current color.



Displays the size of the current database.



Displays the date when the database was created.



Displays the comments. You may enter 256 characters.



Specifies whether the program should perform case sensitive comparison when searching.



Specifies the name of the selected field.



Specifies the type of the selected field.

Type Length in 

bytes

Description

Text 1-256 Text and numbers.

Double 8 Values from 1.79769313486232E308 to 4.94065645841247E–324 

for negative values and 4.94065645841247E–324 to 

1.79769313486232E308 for positive values.

Date 8 Dates and times (stored together). These values are stored in a 8-

byte field and may be treated as a 8-byte floating point number. The 

(positive or negative) integer portion represents the number of days 

from 30 December 1899, midnight and the fractional portion 

represents hours.

Specifies the length of the current field. Please note that the length of the number and date/time fields is fixed and can't be changed.



Displays all fields of the current database. If you want to change the name, type or length of the given field, select it and then modify 

its description in the Name, Type and Length edit fields.



Click this button to remove the selected field from the current database.



Click this button to add a new field to the current database.



Specifies the field of the current database.



Specifies the following:

- the greatest number for number fields

- the greatest length of text strings for text fields

- the latest date/time for date/time fields



Specifies the following:

- the smallest number for number fields

- the smallest length of text strings for text fields

- the earliest date/time for date/time fields



Specifies the following:

- the mean for number fields

- the average text length for text fields

This value is not used for date/time fields.



Specifies the following:

- the sum of numbers for number fields

- the sum of text lengths for text fields

This value is not used for date/time fields.



Specifies whether you want to display the information on the current record set or on all records.



Click this button to update statistics for the current field.



Specifies the GS-Calc document name (full path) to be used as a printing form for GS-Base. You may store three form names. To 

make the given form active, select its number (1, 2 or 3) and check the Use the selected form when printing option.



Specifies whether you want the current form to be active when printing records.



Click this button to browse the available GS-Calc documents which can be used as printing forms.



Click this button to edit the selected form.

Note: You must install GS-Calc to be able to edit the GS-Calc documents.



Specifies whether the selected records should be removed from the current database.



Specifies the range of records which should be removed from the current database.



Specifies the group of records which will be selected. You may choose all records or a range of records from the current record set.



Specifies whether the selection should be removed for the chosen group of records.



Specifies the separator to be used when merging fields.



Specifies the database field containing the recipients' e-mail addresses.



Specifies the name of the sender.



Specifies the e-mail address of the sender. If you enter two e-mail addresses separated with a semicolon (;), the first one will be 

inserted into the "From" field in a message header, and the second one into the "Reply-To" field. Otherwise, both addresses will be 

the same.



Specifies the organization of the sender.



Specifies the SMTP server name for outgoing messages.



Specifies the SMTP server channel. The default value is 25.



Saves the current settings.



Specifies the subject of the message.



Specifies the file to be used as a message form. This can be any text or html file. fields. The merged database fields are 

represented by their names enclosed in double curly braces {{,}}.

For example, if there are two fields: Customer and Number, the form may look like this:

Dear {{Customer}},

Here is your registration number: {{Number}}.



Specify the type of the message form. If you select the text/html form, you should also select the quoted-printable text encoding.



Browse the available forms.



Specifies the character set and the text encoding for the message form.



Displays the list of file attachments.



Click this button to add a file attachment.



Removes the selected file from the list.



Specifies advanced options for the selected file attachment.



Starts sending messages.



Suspends sending messages.



Saves the messages to a text file.



Displays the status of the current process: sent messages and the estimated time needed to complete it.



Specifies the database field containing the file name (full path).



Displays the currently verified file. If the file doesn't exist or is inaccessible, the program displays a respective message.



Click this button to check whether all files pointed by the selected database field exist and are accessible.



Specifies the character set for the selected message form.



Specifies the text encoding for the selected message form.



Specifies whether the selected message forms contains references to the database fields.



Specifies the file attachment type. You may leave the default "application/octet-stream" type.



Specifies the file attachment description. This edit field is empty if it refers to a database field - the suitable description is added 

during the sending procedure and may be different for each message.



Specifies the "Content-Disposition" field in the attachment header. You may leave the default "Attachment" parameter.



Tips

1. When editing fields you may use both a point "." and the currently defined decimal separator to input decimal places in numbers.

2. Before using the Search or Replace command you may select a table column. In this case any processing will be limited to the 

field displayed in that column.

3. If you want to search for records containing an empty text field, use the asterisk "*" as a search expression for this field and then 

use the "Complement of the current record set" predefined search key.

4. When reading and saving records from databases some drivers convert text from OEM character set to ANSI character set. If 

your DBF database uses ANSI set you may change drivers properties manually in the registry database changing the value of the 

DataCodePage entry from OEM to ANSI in the key HKEY_LOCAL_MACHINE\Software\Microsoft\Jet\3.0\Engines\Xbase.

5. After using the Save Copy As command from the File menu the program saves only the currently found records. If you want to 

make a copy of the whole database, you must earlier remove all search expressions.

6. If you use the Convert command from the Edit menu to merge the contents of two fields, GS-Base merges the contents of the 

current field and the next one. This action may mean concatenating two strings or adding numbers and dates.

7. GS-Base treats Excel files as tables and does not use or convert any formulas when reading, modifying and creating the *.xls 

files. To open a range of cells in an Excel 5.0 or Excel 7.0 table, specify the table name followed by a dollar sign and the starting and 

ending cells of the range (e.g. SHEET1$A1:B5).

8. To open and edit a Paradox database which has a primary key, the program needs both the database (*.db) and the index file 

(*.px).

9. When importing a database GS-Base by default saves empty source record fields as empty destiny record fields. If you want any 

text to be used instead of empty fields, edit the NullString entry in the

HKEY_CURRENT_USER\Software\JPS Development\GS-Base\Settings

key in the registry database.

10. The program opens Access databases (*.mdb) in the read/write mode. To open an Access database placed on CD-ROM or any 

other read-only media, you must copy it on your hard disk and remove the read-only file attribute.





Print command (File menu)

Use this command to print a document. This command presents the Print dialog box, where you may specify the range of pages to 

be printed, the number of copies, the destination printer, and other printer setup options.

Note: The Print Selection option is active only when printing the predefined single-record form and means printing the current 

record. This command always refers to the currently found records.



Print dialog box

See: Print command.



Print Progress Dialog

The Printing dialog box is shown during the time that GS-Base is sending output to the printer. The page number indicates the 

progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When you choose this command, the main 

window will be replaced with a print preview window in which one or two pages will be displayed in their printed format. The print 

preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in 

and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print

Bring up the print dialog box, to start a print job.

Next Page

Preview the next printed page.

Prev Page

Preview the previous printed page.

One Page / Two Page

Preview one or two printed pages at a time.

Zoom In

Take a closer look at the printed page.

Zoom Out

Take a larger look at the printed page.

Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents the Print Setup dialog box where you 

specify the printer and its connection.



Print Setup dialog box

See: Print Setup command.




